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1 About Sophos Endpoint Security and Control

Sophos Endpoint Security and Control 9.0 is an integrated suite of security software.

Sophos Anti-Virus detects and cleans up viruses, Trojans, worms, and spyware, as well as adware
and other potentially unwanted applications. The Host Intrusion Prevention System (HIPS)
technology protects your computer from suspicious files and rootkits, unidentified viruses, and
suspicious behavior.

Sophos Application Control blocks unauthorized applications such as Voice over IP, instant
messaging, file sharing, and game software.

Sophos Device Control blocks unauthorized external storage devices and wireless connection
technologies.

Sophos Data Control prevents the accidental leakage of personally-identifiable information from
managed computers.

Sophos Client Firewall prevents worms, Trojans, and spyware from stealing and distributing
sensitive information, and also prevents intrusion from hackers.

Sophos AutoUpdate offers fail-safe updating and can throttle bandwidth when updating over
low-speed network connections.
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2 About the Home page

The Home page is displayed in the right-hand pane when you open the Sophos Endpoint Security
and Control window. It enables you to configure and use the software.

Asyou use Sophos Endpoint Security and Control, the content of the right-hand pane will change.
To return to the Home page, click the Home button on the toolbar.
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3 Sophos groups

3.1 About Sophos groups
Sophos Endpoint Security and Control restricts access to certain parts of the software to members
of certain Sophos groups.

When Sophos Endpoint Security and Control is installed, each user on this computer is initially
assigned to a Sophos group depending on their Windows group.

Windows group Sophos group

Administrators SophosAdministrator
Power Users SophosPowerUser
Users SophosUser

Users who are not assigned to a Sophos group, including Guest users, can only perform the
following tasks:

®m  On-access scanning

m Right-click scanning

SophosUsers

SophosUsers can perform the tasks above and also perform the following tasks:
m  Open the Sophos Endpoint Security and Control window

m Set up and run on-demand scans

m Configure right-click scanning

m Manage (with limited privileges) quarantined items

m Create and configure firewall rules

SophosPowerUsers

SophosPowerUsers have the same rights as SophosUsers, with the addition of the following rights:
m  Greater privileges in Quarantine manager

m  Access to Authorization manager

SophosAdministrators

SophosAdministrators can use and configure any part of Sophos Endpoint Security and Control.
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3.2 Add a user to a Sophos group

If you are a domain administrator or a member of the Windows Administrators group on this
computer, you can change the Sophos group in which a user has membership. You would typically
do this in order to change their access rights to Sophos Endpoint Security and Control.

To add a user to a Sophos group:

Using Windows, open Computer Management.

In the console tree, click Users.

Right-click the user's account, and then click Properties.
On the Member Of tab, click Add.

In Enter the object names to select, type one of the Sophos group names:

A

m SophosAdm ni strat or
m SophosPower User
m SophosUser

6. If you want to validate the Sophos group name, click Check Names.

When the user next logs on to the computer, they will find that their access rights to Sophos
Endpoint Security and Control have changed.

Notes

m To open Computer Management, click Start, and then click Control Panel. Double-click
Administrative Tools, and then double-click Computer Management.

m To remove the user from a Sophos user group, on the Member Of tab, select the group in
Member of, and then click Remove.

3.3 Configure user rights for Quarantine manager

If you are a member of the SophosAdministrator group, you can configure the user rights for
Quarantine manager.

1. On the Configure menu, point to Anti-virus, and then click User rights for Quarantine
manager.
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2. Select the user type that may perform each type of action.

Note: With the exception of the Authorize option, the rights you set here apply only to

Quarantine manager.

Option Description

Users can clean up floppy disk boot sectors.

Clean up sectors

Clean up files Users can clean up documents and programs.

Delete files Users can delete infected files.

Move files Users can move infected files to another folder.

Authorize Users can authorize suspicious items, adware, and PUAs in order to

allow them to run on the computer.

This option applies to both Authorization manager and Quarantine
manager.
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4

4.1

4.2

4.2.1

4.2.2

Using Sophos Anti-Virus

Differences between on-access and on-demand scanning

On-access scanning is your main method of protection against viruses and other threats.

Whenever you access (copy, save, move, or open) a file, Sophos Anti-Virus scans the file and grants
access to it only if it does not pose a threat to your computer or has been authorized for use.

In addition to on-access scanning, Sophos Anti-Virus supplies several types of on-demand scanning
to provide additional protection.

An on-demand scan is a scan that you initiate. You can scan anything from a single file to your
entire computer.

On-access scanning

Temporarily disable on-access scanning

If you are a member of the SophosAdministrator group, you may need to temporarily disable
on-access scanning for maintenance or troubleshooting, and then re-enable it. You can disable
on-access protection and still run on-demand scans on your computer.

Sophos Endpoint Security and Control retains the settings you make here, even after you restart
your computer. If you disable on-access scanning, your computer is unprotected until you re-enable
it.

1. On the Configure menu, point to Anti-virus, and then click On-access scanning.

2. Clear the Enable on-access scanning for this computer check box.

Specify on-access scanning file extensions

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can specify which file extensions are scanned during on-access scanning.

1. On the Configure menu, point to Anti-virus, and then click On-access scanning.



Sophos Endpoint Security and Control Help

2.

Click the Extensions tab, and then set the options as described below.

Scan all files

Click this to enable scanning of all files, regardless of the filename extension.
Allow me to control exactly what is scanned

Click this to restrict scanning to only files with a particular filename extension, specified in the
extension list.

Caution: The extension list includes file types that we recommend are scanned. Be careful if
you alter the list as explained below.

To add a filename extension to the list, click Add. You can use the wildcard ? to match any
single character.

To remove a filename extension from the list, select the extension and click Remove.

To change a filename extension in the list, select the extension and click Edit.

When you select Allow me to control exactly what is scanned, Scan files with no extension
is selected by default. To disable scanning of files with no filename extension, deselect Scan
files with no extension.

4.2.3 Configure on-access scanning

4.2.4

To open the on-access scan settings dialog box:

[QOn the Configure menu, point to Anti-virus, and then click On-access scanning.

Scan inside archive files (page 20)
Scan for Mac viruses (page 21)

Scan all files (page 21)

Scan for adware and PUAs (page 21)
Scan for suspicious files (page 21)
Reset scanned file checksums (page 22)

Exclude files, folders or drives from on-access scanning

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can exclude files, folders or drives from on-access scanning.

1.

On the Configure menu, point to Anti-virus, and then click On-access scanning.
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2. Click the Exclusions tab, and then set the options as described below.
Excluded item

To specify items that should be excluded from scanning, click Add. In the Exclude item dialog
box, specify the type and name of the item to be excluded. Refer to Specifying excluded items
below.

To remove items from the list of excluded items, click Remove.

To change items in the list of excluded items, click Edit.

Specifying excluded items
In the Exclude item dialog box, select the Item type.
Specify the Item name by using the Browse button or typing in the text box.

Note: If you work on a 64-bit platform, the Browse button will not be visible in the Exclude item
dialog.

Further details on specifying item names are given below.
m Filename

You can specify only the name of a file, and Sophos Anti-Virus excludes all files with that name,
wherever they are located. For example

fred. brmp
causes Sophos Anti-Virus to exclude all files called fred.bmp, wherever they are located.
m Full path

You can specify the exact location and name of a file, and Sophos Anti-Virus excludes only
that particular file. The path can include the drive or the share. For example

C.\ M scel | aneous\ fred. bnmp

causes Sophos Anti-Virus to exclude fred.bmp in the Miscellaneous folder on the C: drive.

\\ Server1\Users\ Fred\Letter.rtf

causes Sophos Anti-Virus to exclude Letter.rtf in the Fred folder in the Users share on Serverl.

If you do not specify the drive or share, Sophos Anti-Virus matches the path at the root of any
drive or share.

m Partial path

You can specify a drive or share, and Sophos Anti-Virus excludes everything from that drive
or share and below. For example

A

causes Sophos Anti-Virus to exclude everything on the A: drive.
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4.2.5

You can specify a folder, and Sophos Anti-Virus excludes everything from that folder and
below. For example

D: \ Tool s\

causes Sophos Anti-Virus to exclude everything from the Tools folder on the D: drive and all
subfolders.

You can specify a folder and filename, and Sophos Anti-Virus excludes any folder and filename
that match. For example

| ogs\ I og. t xt
causes Sophos Anti-Virus to exclude log.txt in any folder called logs on any drive or share.

Wildcards

The wildcard ? can be used only in a filename or extension. It generally matches any single character.
However, when used at the end of a filename or extension, it matches any single character or no
characters. For example file??.txt matches file.txt, filel.txt and file12.txt but not file123.txt.

The wildcard * can be used only in a filename or extension, in the form [filename].* or
*.[extension]. For example, file*.txt, file.txt* and file.*txt are invalid.

Multiple filename extensions

Filenames with multiple extensions are treated as if the last extension is the extension and the rest
are part of the filename. For example,

[filename].[extension]].[extension2] means the filename is [filename].[extension1] and the
extension is [extension2].

Standard naming conventions

The filename or path is validated against standard naming conventions (e.g. a folder name may
contain spaces but may not contain only spaces).

Change when on-access scanning occurs
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can specify whether Sophos Anti-Virus scans files when they are opened, when they are saved,
or when they are renamed.

1. On the Configure menu, point to Anti-virus, and then click On-access scanning.

2. Click the Scanning tab, and then set the options as described below.

To specify that files must be scanned when they are opened, select On read. This is the
recommended option.

To specify that files must be scanned when they are saved, selectOn write.

To specify that files must be scanned when they are renamed, select On rename.

11
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4.2.6 Detect suspicious behavior and buffer overflows

4.2.7

4.2.8

12

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

If you are a member of the SophosAdministrator group, you can change the settings for detecting
suspicious behavior and buffer overflows:

1. On the Configure menu, point to Anti-virus, and then click HIPS runtime behavior analysis
to display the HIPS runtime behavior analysis dialog box.

2. To enable or disable detection of suspicious behavior, select or deselect Detect suspicious
behavior, respectively.

To enable or disable detection of buffer overflows, select or deselect Detect buffer overflows,
respectively.

Note: The buffer overflow detection feature is not available for Windows Vista and 64-bit
versions of Windows. These operating systems are protected against buffer overflows by
Microsoft’s Data Execution Prevention (DEP) feature.

3. If this is a new installation of Sophos Anti-Virus on this computer, by default, suspicious
behavior and buffer overflows are detected but not blocked. If this is an upgrade, by default,
suspicious behavior and buffer overflows are not detected.

ﬂ Caution: We recommend that you run Sophos Anti-Virus in detect-only mode for a time and
** authorize the programs you need before enabling automatic blocking of suspicious behavior
and buffer overflows. This approach avoids blocking programs that your users may need.

To enable blocking of suspicious behavior and buffer overflows as well as detection, clear the
Alert only check box.

About scanning for controlled applications
A controlled application is an application that is prevented from running on your computer by
your organisation's security policy.

Scanning for controlled applications is enabled or disabled by a management console as part of
an application control policy, and is included as part of on-access scanning.

For information about on-access scanning, see Differences between on-access and on-demand
scanning (page 8).

Disable scanning for controlled applications

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.
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4.3

4.3.1

4.3.2

If scanning for controlled applications is enabled, it might prevent you from uninstalling some
applications. If you are a member of the SophosAdministrator group, you can temporarily disable
scanning for controlled applications on this computer.

To disable scanning for controlled applications:

1. On the Configure menu, click Application control.

2. Clear the Enable on-access scanning check box.

On-demand scanning

Types of on-demand scan

An on-demand scan is a scan that you initiate. You can scan anything from a single file to your
entire computer.

The following types of on-demand scan are supplied with Sophos Anti-Virus:

m Full computer scanning

m Right-click scanning

m Custom scanning

Full computer scanning

Scan your entire computer, including the boot sector and system memory, at any time.
m Run a full computer scan (page 16)

Right-click scanning

Scan a file, folder, or drive in Windows Explorer at any time.

m Run a right-click scan (page 17)

Custom scanning

Scan specific sets of files or folders. You can either manually run a custom scan or schedule it to
run unattended.

m Run a custom scan (page 19)

m Schedule a custom scan (page 19)

Specify on-demand scanning file extensions

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

13
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You can specify which file extensions are scanned during on-demand scanning.

1.
2.

I:}

On the Configure menu, click On-demand extensions and exclusions.

Click the Extensions tab, and then set the options as described below.

Scan all files

Click this to enable scanning of all files, regardless of the filename extension.
Allow me to control exactly what is scanned

Click this to restrict scanning to only files with a particular filename extension, specified in the
extension list.

Caution: The extension list includes file types that we recommend are scanned. Be careful if
you alter the list as explained below.

To add a filename extension to the list, click Add. You can use the wildcard ? to match any
single character.

To remove a filename extension from the list, select the extension and click Remove.

To change a filename extension in the list, select the extension and click Edit.

When you select Allow me to control exactly what is scanned, Scan files with no extension
is selected by default. To disable scanning of files with no filename extension, deselect Scan
files with no extension.

4.3.3 Exclude files, folders or drives from on-demand scanning

14

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can exclude files, folders or drives from on-demand scanning.

Note: The procedure described below applies to all on-demand scans. To exclude items from a
particular on-demand scan, refer to Create a custom scan (page 17).

1.

On the Configure menu, point to Anti-virus, and then click On-demand extensions and
exclusions.

Click the Exclusions tab. Set the options as described below.
Excluded item

To specify items that should be excluded from scanning, click Add. In the Exclude item dialog
box, specify the type and name of the item to be excluded. Refer to Specifying excluded items
below.

To remove items from the list of excluded items, click Remove.

To change items in the list of excluded items, click Edit.
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Specifying excluded items
In the Exclude item dialog box, select the Item type.
Specify the Item name by using the Browse button or typing in the text box.

Note: If you work on a 64-bit platform, the Browse button will not be visible in the Exclude item
dialog.

Further details on specifying item names are given below.
m Filename

You can specify only the name of a file, and Sophos Anti-Virus excludes all files with that name,
wherever they are located. For example

fred. bmp
causes Sophos Anti-Virus to exclude all files called fred.bmp, wherever they are located.
m Full path

You can specify the exact location and name of a file, and Sophos Anti-Virus excludes only
that particular file. The path can include the drive or the share. For example

C:\ M scel | aneous\fred. bnp

causes Sophos Anti-Virus to exclude fred.bmp in the Miscellaneous folder on the C: drive.
\\Server1\ Users\Fred\Letter.rtf

causes Sophos Anti-Virus to exclude Letter.rtf in the Fred folder in the Users share on Serverl.

If you do not specify the drive or share, Sophos Anti-Virus matches the path at the root of any
drive or share.

m Partial path

You can specify a drive or share, and Sophos Anti-Virus excludes everything from that drive
or share and below. For example

A
causes Sophos Anti-Virus to exclude everything on the A: drive.

You can specify a folder, and Sophos Anti-Virus excludes everything from that folder and
below. For example

D\ Tool s\

causes Sophos Anti-Virus to exclude everything from the Tools folder on the D: drive and all
subfolders.

You can specify a folder and filename, and Sophos Anti-Virus excludes any folder and filename
that match. For example

| ogs\ I og. t xt

causes Sophos Anti-Virus to exclude log.txt in any folder called logs on any drive or share.

15
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4.3.4

4.3.5

16

Wildcards

The wildcard ? can be used only in a filename or extension. It generally matches any single character.
However, when used at the end of a filename or extension, it matches any single character or no
characters. For example file??.txt matches file.txt, filel.txt and file12.txt but not file123.txt.

The wildcard * can be used only in a filename or extension, in the form [filename].* or
* [extension]. For example, file*.txt, file.txt* and file.*txt are invalid.

Multiple filename extensions

Filenames with multiple extensions are treated as if the last extension is the extension and the rest
are part of the filename. For example,

[filename].[extension]l].[extension2] means the filename is [filename].[extension]] and the
extension is [extension2].

Standard naming conventions

The filename or path is validated against standard naming conventions (e.g. a folder name may
contain spaces but may not contain only spaces).

Run a full computer scan

Note: The Scan my computer scan does not scan Mac files stored on Windows computers. If you
want Sophos Anti-Virus to scan executable Mac files, you must set up a custom on-demand scan
and enable scanning of Mac files for that scan.

For more information on custom on-demand scans, see Create a custom scan (page 17).
For more information on scanning Mac files, see Scan for Mac viruses (page 21).

To scan your entire computer system, including the boot sector and system memory:

[On the Home page, under Anti-virus and HIPS, click Scan my computer.
For information about the Home page, see About the Home page (page 4).

A progress dialog box is displayed and the Activity summary appears in the Sophos Endpoint
Security and Control window.

If any threats or controlled applications are found, click More and refer to the Managing quarantine
items section.

Configure right-click scanning

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it will not override any changes you make here.

[QOn the Configure menu, point to Anti-virus, and then click Right-click scanning.

m Scan inside archive files (page 20)
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4.3.6

4.4

4.4.1

Scan for Mac viruses (page 21)
Scan all files (page 21)
Scan for adware and PUAs (page 21)

Scan for suspicious files (page 21)

Run a right-click scan

You can scan files, folders and drives from Windows Explorer or the desktop by running a
right-click scan.

1.

2.

Using Windows Explorer, or on the desktop, select the file, folder or disk drive you want to
scan.

You can select multiple files and folders.

Right-click the selection, and then click Scan with Sophos Anti-Virus.

If any threats or controlled applications are found, click More, and then refer to the Managing
quarantine items section of this Help file.

Custom scans

Create a custom scan

. On the Home page, under Anti-virus and HIPS, click Scans.

For information about the Home page, see About the Home page (page 4).

Click Set up a new scan.

. In the Scan name box, type a name for the scan.

In the Items to scan panel, select the drives and folders you want to scan. To do this, select the
check box to the left of each drive or folder. To learn about the icons that appear in the check
boxes, refer to Representation of items to scan (page 18).

Note: Drives or folders that are unavailable (because they are offline or have been deleted) are
displayed in a strikethrough font. They are removed from the Items to scan panel if they are
deselected or if there is a change in the selection of their parent drive or folder(s).

. To configure the scan further, click Configure this scan. (Refer to Configure a custom scan

(page 18) for more information.)

Click Save to save the scan or Save and start to save and run the scan.

17
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4.4.2 Representation of items to scan

In the Items to scan panel, different icons are displayed in the check box next to each item (drive
or folder), depending on which items will be scanned. These icons are shown below with

explanations.

Icon Explanation

F The item and all sub-items are not selected for scanning.

The item and all sub-items are selected for scanning.

The item is partially selected: the item is not selected, but some sub-items are
selected for scanning.

The item and all sub-items are excluded from this particular scan.

The item is partially excluded: the item is selected, but some sub-items are
excluded from this particular scan.

& The item and all sub-items are excluded from all on-demand scans, because
of an on-demand exclusion that has been set up. For information, see Exclude
files, folders or drives from on-access scanning (page 9).

4.4.3 Configure a custom scan

1. On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

2. In the Available scans list, select the scan you want to edit, and then click Edit.

3. Click Configure this scan.

m Scan inside archive files (page 20)

m Scan for Mac viruses (page 21)

m Scan all files (page 21)

m Scan for adware and PUAs (page 21)
m Scan for suspicious files (page 21)

m Scan for rootkits (page 22)

18
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4.4.4 Schedule a custom scan

4.4.5

If you are a member of the SophosAdministrator group, you can schedule a custom scan, or view
and edit scheduled scans created by other users.

1.

On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

In the Available scans list, select the scan you want to edit, and then click Edit.

3. Click Schedule this scan.

In the Schedule scan dialog box, select Enable schedule.
Select the day(s) on which the scan should run.
Add the time(s) by clicking Add.

If necessary, remove or edit a time by selecting it and clicking Remove or Edit, respectively.

. Type the user name and password. Make sure that the password is not blank.

The scheduled scan runs with the access rights of that user.

Run a custom scan

Note: You cannot manually run scheduled custom scans. Scheduled scans are displayed in the
Available scans list with a clock icon.

1.

On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

In the Available scans list, select the scan you want to run, and then click Start.

A progress dialog box is displayed and the Activity summary panel appears in the Sophos
Endpoint Security and Control window.

If any threats or controlled applications are found, click More and refer to Managing quarantine
items.

4.4.6 Rename a custom scan

On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

In the Available scans list, select the scan you want to edit, and then click Edit.

3. In the Scan name box, type the new name for the scan.

19
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4.4.7

4.4.8

4.5

4.5.1

20

Delete a custom scan

1. On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

2. In the Available scans list, select the scan you want to delete, and then click Delete.

View the log for a custom scan

1. On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

2. In the Available scans list, click Summary for the custom scan.

3. In the Summary dialog box, click the link at the bottom.

From the log page, you can copy the log to the clipboard, or email, or print the log.

To find specific text in the log, click Find and enter the text you want to find.

Additional scanning options

Scan inside archive files

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

Note: We recommend that you do not enable this option, for the following reasons:

m Scanning inside archive files makes scanning significantly slower.

m  Whether you enable this option or not, when you open a file extracted from the archive file,
the extracted file is scanned.

m Whether you enable this option or not, files compressed with dynamic compression utilities
(PKLite, LZEXE and Diet) are scanned.

However, you may want to enable the option so that the contents of an archive or compressed file
are scanned before it is downloaded or emailed from your computer.

To scan inside archive files:

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. On the Options tab, select the Scan inside archive files check box.
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4.5.2

4.5.3

4.5.4

4.5.5

Scan for Mac viruses
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can enable Sophos Anti-Virus to scan executable Mac files stored on Windows computers.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. On the Options tab, select the Scan for Macintosh viruses check box.

Scan all files
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can enable Sophos Anti-Virus to scan all files, although this will affect computer performance.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. On the Options tab, select the Scan all files check box.

Scan for adware and PUAs

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. On the Options tab, select the Scan for adware and PUAs check box.

Scan for suspicious files
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

A suspicious file is a file that exhibits a combination of characteristics that are commonly, but not
exclusively, found in viruses.

To scan for suspicious files:

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. On the Options tab, select the Scan for suspicious files (HIPS) check box.

21



Sophos Endpoint Security and Control Help

4.5.6

4.5.7

4.6

4.6.1

22

Scan for rootkits
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

If you are a member of the SophosAdministrator group, scanning for rootkits is always performed
when you run a full computer scan.

You can also scan for rootkits as part of a custom scan.

To scan for rootkits:

1. On the Home page, under Anti-virus and HIPS, click Scans.
For information about the Home page, see About the Home page (page 4).

2. In the Available scans list, select the scan you want to edit, and then click Edit.
3. Click Configure this scan.
4. On the Options tab, select the Scan for rootkits check box.

Reset scanned file checksums

The list of scanned file checksums is reset when a Sophos Anti-Virus update occurs, or when you
restart your computer. The list is then rebuilt with new data as files are scanned by
Sophos Anti-Virus.

You can reset the list of scanned file checksums from within Sophos Endpoint Security and Control
if you do not want to restart your computer.

To reset scanned file checksums:

1. On the Configure menu, point to Anti-virus, and then click On-access scanning.

2. On the Options tab, click Purge cache.

Configuring alerts

Configure anti-virus desktop messaging

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

To enable Sophos Anti-Virus to display desktop messages when a threat is found, do as follows.
This applies only to on-access scanning.

1. On the Configure menu, point to Anti-virus, and then click Messaging.
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2. In the Messaging dialog box, click the Desktop messaging tab. Set the options as described
below.

Enable desktop messaging

Select this to enable Sophos Anti-Virus to display desktop messages when a threat is found.
Messages to send

Select the events for which you want Sophos Anti-Virus to display desktop messages.
User-defined message

In this text box, you can type a message that will be added to the end of the standard message.

4.6.2 Configure anti-virus email alerting
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

To enable Sophos Anti-Virus to send email alerts when a threat is found or an error occurs, do as
follows. This applies to on-access, on-demand and right-click scanning.

1. On the Configure menu, point to Anti-virus, and then click Messaging.

2. In the Messaging dialog box, click the Email alerting tab. Set the options as described below.
Enable email alerting
Select this to enable Sophos Anti-Virus to send email alerts.
Messages to send

Select the events for which you want Sophos Anti-Virus to send email alerts. Scanning errors
include instances when Sophos Anti-Virus is denied access to an item that it attempts to scan.

Sophos Anti-Virus does not send email alerts for threats that are detected by web page scanning
because the threats are not downloaded to your computer. Therefore, there is no need to take
any action.

Recipients

Click Add or Remove to add or remove, respectively, email addresses to which email alerts
should be sent. Click Edit to change an email address you have added.

Configure SMTP

Click this to change the settings for the SMTP server and the language of the email alerts. (Refer
to the table below.)
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Configure SMTP settings

SMTP server In the text box, type the host name or IP address of the
SMTP server. Click Test to test that a connection to the
SMTP server can be made. (This does not send a test
email.)

SMTP ‘sender’ address In the text box, type an email address to which bounces
and non-delivery reports can be sent.

SMTP ‘reply to’ address As email alerts are sent from an unattended mailbox, you
can type in the text box an email address to which replies
to email alerts can be sent.

Language Click the drop-down arrow, and select the language in
which email alerts should be sent.

4.6.3 Configure anti-virus SNMP messaging

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

To enable Sophos Anti-Virus to send SNMP messages when a threat is found or an error occurs,
do as follows. This applies to on-access, on-demand and right-click scanning.

1. On the Configure menu, point to Anti-virus, and then click Messaging.
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2. In the Messaging dialog box, click the SNMP messaging tab. Set the options as described
below.

Enable SNMP messaging
Select this to enable Sophos Anti-Virus to send SNMP messages.
Messages to send

Select the events for which you want Sophos Anti-Virus to send SNMP messages. Scanning
errors include instances when Sophos Anti-Virus is denied access to an item that it attempts
to scan.

Sophos Anti-Virus does not send SNMP messages for threats that are detected by web page
scanning because the threats are not downloaded to your computer. Therefore, there is no
need to take any action.

SNMP trap destination

In the text box, type the IP address or name of the computer to which alerts are sent.
SNMP community name

In the text box, type the SNMP community name.

Test

Click this to send a test SNMP message to the SNMP trap destination you have specified.

4.6.4 Configure anti-virus event logging

To enable Sophos Anti-Virus to add alerts to the Windows 2000 or later event log when a threat
is found or an error occurs, do as follows. This applies to on-access, on-demand and right-click
scanning.

1. On the Configure menu, point to Anti-virus, and then click Messaging.

2. In the Messaging dialog box, click the Event log tab. Set the options as described below.
Enable event logging
Select this to enable Sophos Anti-Virus to send messages to the Windows event log.
Messages to send

Select the events for which you want Sophos Anti-Virus to send messages. Scanning errors
include instances when Sophos Anti-Virus is denied access to an item that it attempts to scan.

Sophos Anti-Virus does not send messages for threats that are detected by web page scanning
because the threats are not downloaded to your computer. Therefore, there is no need to take
any action.
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4.7 Scanning log

4.7.1 Configure the scanning log

4.7.2

4.8

The scanning log for this computer is stored in the following location:

C. \Docurents and Settings\Al |l Users\Application Data\ Sophos\ Sophos
Anti-Virus\| ogs\ SAV. t xt

1. On the Configure menu, point to Anti-virus, and then click Logging.
2. In the Configure logging for this computer dialog box, set the options as described below.

Logging level

To stop anything being logged, click None. To log summary information, error messages and
so on, click Normal. To log most information, including files scanned, major stages of a scan,
and so on, click Verbose.

Log archiving

To enable the log file to be archived monthly, select Enable archiving. The archive files are
stored in the same folder as the log file. Select the Number of archive files to store before the
oldest one is deleted. Select Compress log to reduce the size of the log file.

View the scanning log

[ On the Home page, under Anti-virus and HIPS, click View anti-virus and HIPS log.
For information about the Home page, see About the Home page (page 4).

From the log page, you can copy the log to the clipboard, or email, or print the log.

To find specific text in the log, click Find and enter the text you want to find.

Cleaning up

4.8.1 About cleanup

26

Cleanup eliminates threats on your computer by doing one of the following:
m Removing a virus from a file or boot sector

m Moving or deleting a suspicious file

m Deleting an item of adware or PUA

Cleanup does not undo any actions the threat has already taken.
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4.8.2

4.8.3

Cleaning up documents does not repair any changes the virus has made to the document.

Cleaning up programs should be used only as a temporary measure. You should subsequently
replace cleaned programs from the original disks or a clean backup.

Cleanup is not available for threats that are detected by web page scanning, because the threats
are not downloaded to your computer. In this case, there is no need to take any action.

Open the scan settings dialog box

To open the right-click scan settings dialog box:

m  On the Configure menu, point to Anti-virus, and then click Right-click scanning.
To open the custom scan settings dialog box:

1. On the Home page, under Anti-virus and HIPS, click Scans.

For information about the Home page, see About the Home page (page 4).
2. In the Available scans list, select the scan you want to edit, and then click Edit.
3. Click Configure this scan.

To open the on-access scan settings dialog box:

m  On the Configure menu, point to Anti-virus, and then click On-access scanning.

Set up automatic cleanup of viruses/spyware
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

When on-access scanning is turned on, or when you run an on-demand or right-click scan,
Sophos Anti-Virus can automatically do the following:

m Clean up many infected items
m Make infected items safe in ways other than cleanup

Note: Automatic cleanup of multi-component infections is not available for on-access scanning.
To clean multi-component infections from your computer, use Quarantine manager. For
information about Quarantine manager, see Deal with adware and PUAs in quarantine (page 32).

Any actions that Sophos Anti-Virus takes against infected items are recorded in the log for this
computer or log for the on-demand scan. For information, see View the scanning log (page 26)
or View the log for a custom scan (page 20).

To fully clean some multi-component infections from your computer, you will need to restart the
computer. If this is the case, you will be given an option to restart your computer immediately or
later. The final cleanup steps will be performed after the computer is restarted.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)
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2. In the scan settings dialog box, click the Cleanup tab. Set the options as described below.

m  Select Automatically clean up items that contain virus/spyware to enable Sophos Anti-Virus
to disinfect floppy disk boot sectors, documents, programs and anything else that is selected
for scanning. Cleanup of documents does not repair any side-effects of the virus in the
document. (Refer to Get cleanup information (page 29) to find out how to view details on
the Sophos website of the virus’s side-effects.)

m  Sophos Anti-Virus can make an infected file safe in ways other than cleanup. You can select
other actions that you want Sophos Anti-Virus to take against infected files if you do not
use automatic cleanup, or if cleanup fails. However,

i"l- Caution: You should use these options only if advised to by Sophos technical support.
Otherwise, use Quarantine manager to clean your computer from viruses/spyware found
by Sophos Anti-Virus. For information about Quarantine manager, see Deal with adware
and PUAs in quarantine (page 32).

Click Delete to dispose of the file. Click Move to to move the file to another folder, which you
can select using Browse. Moving an executable file reduces the likelihood of it being run.

You cannot automatically move a multi-component infection.

Note: To learn how to clean your computer from viruses/spyware using Quarantine manager,
refer to Deal with viruses/spyware in quarantine (page 31).

Set up automatic cleanup of adware and PUAs

When you run an on-demand or right-click scan, Sophos Anti-Virus can automatically clean
adware and PUAs from your computer.

Note: Automatic cleanup of adware and PUAs is not available for on-access scanning. To clean
unwanted adware and PUAs from your computer, use Quarantine manager. For information
about Quarantine manager, see Deal with adware and PUAs in quarantine (page 32).

Any actions that Sophos Anti-Virus takes against adware and PUAs are logged in the log for this
computer or log for the on-demand scan. For information, see View the scanning log (page 26)
or View the log for a custom scan (page 20).

To fully clean some adware and PUAs consisting of several components from your computer, you
will need to restart the computer. If this is the case, you will be given an option to restart your
computer immediately or later. The final cleanup steps will be performed after the computer is
restarted.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. In the scan settings dialog box, click the Cleanup tab.
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4.8.5

4.8.6

3. Select Automatically clean up adware/PUAs to enable Sophos Anti-Virus to remove all known
components of adware and PUAs from the computer for all users. Cleanup does not repair
any changes the adware or PUA has already made. (Refer to Get cleanup information (page 29)
to find out how to view details on the Sophos website of the adware or PUA’s side-effects.)

Note: To learn how to clean your computer from adware and PUAs using Quarantine manager,
refer to Deal with adware and PUAs in quarantine (page 32).

Set up automatic cleanup of suspicious files
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

When on-access scanning is turned on, or when you run an on-demand or right-click scan,
Sophos Anti-Virus can automatically delete or move suspicious files.

A suspicious file is a file that exhibits a combination of characteristics that are commonly, but not
exclusively, found in viruses.

1. Open the scan settings dialog box for the type of scanning that you want to configure. (Refer
to Open the scan settings dialog box (page 27).)

2. In the scan settings dialog box, click the Cleanup tab. In the Suspicious files panel, set the
options as described below.

ﬂ Caution: You should use these options only if advised to by Sophos technical support.
Otherwise, use Quarantine manager to clean your computer from viruses/spyware found by
Sophos Anti-Virus. For information about Quarantine manager, see Deal with suspicious files
in quarantine (page 33).

Click Delete to dispose of the file. Click Move to to move the file to another folder, which you
can select using Browse. Moving an executable file reduces the likelihood of it being run.

Note: To learn how to clean your computer from suspicious files using Quarantine manager,
refer to Deal with suspicious files in quarantine (page 33).

Get cleanup information

When a threat is found on your computer, it is very important that you check the threat analysis
on the Sophos website for information on the threat and cleanup advice. You can do this from
the following places:

m The desktop alert (on-access scanning)
m The scan progress dialog box (on-demand and right-click scanning)

m Quarantine manager (all scanning types)
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4.9.1

30

Get information via the desktop alert

If on-access scanning is enabled on your computer, Sophos Anti-Virus displays a desktop alert
when a threat is found. In the message box, click the name of the threat that you want to find out
about.

Sophos Anti-Virus connects you to the analysis of the threat on the Sophos website.

Get information via the scan progress dialog box

For an on-demand scan or a scan run from a right-click menu, in the log that is displayed in the
scan progress dialog box (or scan summary dialog box, displayed after the scan has finished), click
the name of the threat that you want to find out about.

Sophos Anti-Virus connects you to the analysis of the threat on the Sophos website.

Get information via Quarantine manager

1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items. For
information about the Home page, see About the Home page (page 4).

2. In the Name column, click the name of the threat that you want to find out about.

Sophos Anti-Virus connects you to the analysis of the threat on the Sophos website.

Managing quarantine items

About Quarantine manager
Quarantine manager enables you to deal with the items found by scanning that were not eliminated
automatically during scanning. Each item is here for one of the following reasons.

m No cleanup options (clean up, delete, move) were chosen for the type of scan that found the
item.

m A cleanup option was chosen for the type of scan that found the item but the option failed.
m The item is multiply-infected and still contains additional threats.

m The threat has only been partially detected, and a full computer scan is needed to fully detect
it. To find out how to do this, refer to Run a full computer scan (page 16).

m The item exhibits suspicious behavior.
m The item is a controlled application.

Note: Adware, PUAs, and multi-component infections detected during on-access scanning are
always listed in Quarantine manager. Automatic cleanup of adware, PUAs, and multi-component
infections is not available for on-access scanning.

A cleanup option may have failed because of insufficient access rights. If you have greater rights,
you can use Quarantine manager to deal with the item(s).
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4.9.2

Threats that are detected during web page scanning are not listed in Quarantine manager because
the threats are not downloaded to your computer. Therefore, there is no need to take any action.

Deal with viruses/spyware in quarantine

Note: Virus here is used to refer to any virus, worm, Trojan, or other malicious software.
1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items.
For information about the Home page, see About the Home page (page 4).

2. In the Show list, click Viruses/spyware.

Information about each item is shown in the columns.

Name displays the identity that Sophos Anti-Virus has detected. To learn more about the
virus/spyware, click the identity, and Sophos Anti-Virus connects you to the analysis of the
virus/spyware on the Sophos website.

Details displays the name and location of the item. If the item is associated with a rootkit, it is

displayed as “Hidden”. If a more link is displayed next to the filename, this means that the item
is infected with a multi-component infection. Click the link to see the list of other components
that are part of the infection. If any of the components are associated with a rootkit, the dialog
box indicates that some components are hidden.

Available actions displays actions that you can perform on the item. Unless the item is hidden,
there are three actions: Clean up, Delete, and Move, described below. If you click one of the actions,
the action is performed on the item, following confirmation. Hidden files can only be cleaned up.

Dealing with the infected items
To deal with the viruses/spyware, use the buttons described below.
Select all/Deselect all

Click these buttons to select or deselect all the items. This enables you to perform the same action
on a group of items. To select or deselect a particular item, select the check box to the left of the
item type.

Clear from list

Click this to remove selected items from the list, if you are sure that they do not contain a virus
or spyware. This does not delete the items from disk, however.

Perform action
Click this to display a list of actions that you can perform on the selected items.

m Click Clean up to remove a virus or item of spyware from the selected items. Cleanup of
documents does not repair any side-effects of the virus in the document.

Note: To fully clean some viruses/spyware consisting of several components from your
computer, or to clean up hidden files, you will need to restart the computer. If this is the case,
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you will be given an option to restart your computer immediately or later. The final cleanup
steps will be performed after the computer is restarted.

m Click Delete to delete the selected items from your computer. Use this function with care.

m Click Move to move the selected items to another folder. The items are moved to the folder
that was specified when cleanup was set up. Moving an executable file reduces the likelihood
of it being run. Use this function with care.

Caution: Sometimes, if you delete or move an infected file, your computer may stop working
properly because it cannot find the file. Also, an infected file may only be part of a multiple
infection, in which case deleting or moving this particular file will not clean your computer from
the infection. In this case, contact Sophos technical support to get assistance in dealing with the
items.

For information about contacting technical support, see Technical support (page 82).

To configure what action you can perform, refer to Configure user rights for Quarantine manager
(page 6).

Deal with adware and PUAs in quarantine

1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items.

For information about the Home page, see About the Home page (page 4).
2. In the Show list, click Adware or PUAs.

Information about each item is shown in the columns.

Name displays the identity that Sophos Anti-Virus has detected. To learn more about the adware
or PUA, click the identity, and Sophos Anti-Virus connects you to the analysis of the adware or
PUA on the Sophos website.

Details displays the subtype of the adware or PUA. If the item is associated with a rootKkit, it is
displayed as “Hidden”. If a more link is displayed next to the subtype, this means that the item is
a multi-component item of adware or PUA. Click the link to see the list of other components that
are part of the adware or PUA. If any of the components are associated with a rootkit, the dialog
box indicates that some components are hidden.

Available actions displays actions that you can perform on the item. There are two actions:
Authorize and Clean up, described below. If you click one of the actions, the action is performed
on the item, following confirmation.

Dealing with the adware and PUAs

To deal with the adware and PUAs, use the buttons described below.

Select all/Deselect all
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4.9.4

Click these buttons to select or deselect all the items. This enables you to perform the same action
on a group of items. To select or deselect a particular item, select the check box to the left of the
item type.

Clear from list

Click this to remove selected items from the list, if you trust them. This does not delete the items
from disk, however.

Perform action
Click this to display a list of actions that you can perform on the selected items.

m Click Authorize to authorize the selected items on the computer, if you trust them. This adds
the items to the list of authorized adware and PUAs so that Sophos Anti-Virus does not prevent
them from running on your computer.

m Click Clean up to remove all known components of selected items from the computer for all
users. To clean adware and PUAs from the computer, you must be a member of both Windows
Administrators and SophosAdministrator groups.

Note: To fully clean some adware and PUAs consisting of several components from your computer,
or to clean up hidden files, you will need to restart the computer. If this is the case, you will be
given an option to restart your computer immediately or later. The final cleanup steps will be
performed after the computer is restarted.

To configure what actions you can perform, refer to Configure user rights for Quarantine manager
(page 6).

To see the list of known and authorized adware and PUAs, click Configure authorization.

Deal with suspicious files in quarantine

A suspicious file is a file that exhibits a combination of characteristics that are commonly, but not
exclusively, found in viruses.

1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items.
For information about the Home page, see About the Home page (page 4).

2. In the Show list, click Suspicious files.

Information about each item is shown in the columns.

Name displays the identity that Sophos Anti-Virus has detected. To learn more about the suspicious
file, click the identity, and Sophos Anti-Virus connects you to the analysis of the suspicious file
on the Sophos website.

Details displays the name and location of the item. If the item is associated with a rootkit, it is
displayed as “Hidden”.

Available actions displays actions that you can perform on the item. Unless the item is hidden,
there are three actions: Authorize, Delete and Move, described below. If you click one of the
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actions, the action is performed on the item, following confirmation. Hidden files can only be
authorized.

Dealing with the suspicious files
To deal with the suspicious files, use the buttons described below.
Select all/Deselect all

Click these buttons to select or deselect all the items. This enables you to perform the same action
on a group of items. To select or deselect a particular item, select the check box to the left of the
item type.

Clear from list

Click this to remove selected items from the list, if you trust them. This does not delete the items
from disk, however.

Perform action
Click this to display a list of actions that you can perform on the selected items.

m Click Authorize to authorize the selected items on the computer, if you trust them. This adds
the items to the list of authorized suspicious items so that Sophos Anti-Virus does not prevent
them from being accessed.

m Click Delete to delete the selected items from your computer. Use this function with care.

m Click Move to move the selected items to another folder. The items are moved to the folder
that was specified when cleanup was set up. Moving an executable file reduces the likelihood
of it being run. Use this function with care.

1.} Caution: Sometimes, if you delete or move an infected file, your computer may stop working
* .
properly because it cannot find the file.

To configure what actions you can perform, refer to Configure user rights for Quarantine manager

(page 6).

To see the list of authorized suspicious files, click Configure authorization.

4.9.5 Deal with suspicious behavior in quarantine

Suspicious behavior is activity that appears to be malicious.

1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items.

For information about the Home page, see About the Home page (page 4).

2. In the Show list, click Suspicious behavior.

Information about each item is shown in the columns.
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Name displays the identity that Sophos Anti-Virus has detected. To learn more about the behavior,
click the identity, and Sophos Anti-Virus connects you to the analysis of the behavior on the
Sophos website.

Details displays the name and location of the item.

Available actions displays actions that you can perform on the item. If you have enabled blocking
of suspicious behavior, there is one action: Authorize, described below. If you click the action, the
action is performed on the item, following confirmation.

Dealing with the suspicious behavior
To deal with the suspicious behavior, use the buttons described below.
Select all/Deselect all

Click these buttons to select or deselect all the items. This enables you to perform the same action
on a group of items. To select or deselect a particular item, select the check box to the left of the
item type.

Clear from list

Click this to remove selected items from the list, if you trust them. This does not delete the items
from disk, however.

Perform action
Click this to display a list of actions that you can perform on the selected items.

m Click Authorize to authorize the selected items on the computer, if you trust them. This adds
the items to the list of authorized suspicious items so that Sophos Anti-Virus does not prevent
the behavior.

To configure what actions you can perform, refer to Configure user rights for Quarantine manager
(page 6).

To see the list of authorized suspicious behavior, click Configure authorization.

Deal with controlled applications in quarantine

A controlled application is an application that is prevented from running on your computer by
your organisation's security policy.

1. On the Home page, under Anti-virus and HIPS, click Manage quarantine items.
For information about the Home page, see About the Home page (page 4).

2. In the Show list, click Controlled applications.

Information about each item is shown in the columns.

Name displays the identity that Sophos Anti-Virus has detected. To learn more about the controlled
application, click the identity, and Sophos Anti-Virus connects you to the analysis of the controlled
application on the Sophos website.
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Details displays the subtype of the controlled application. If a more link is displayed next to the
subtype, click it to see the list of other components that are part of the controlled application.

Available actions displays actions that you can perform on the item. However, there are no actions
available for controlled applications apart from clearing the item from the list, described below.

Dealing with the controlled applications
To deal with the controlled applications, use the buttons described below.
Select all/Deselect all

Click these buttons to select or deselect all the items. This enables you to perform the same action
on a group of items. To select or deselect a particular item, select the check box to the left of the
item type.

Clear from list

Click this to remove selected items from the list. This does not delete the items from disk, however.
Controlled applications must be authorized by the central console before you can use them.

Authorizing items for use

Authorize adware and PUAs for use
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

If you want to run adware or an application that Sophos Anti-Virus has classified as potentially
unwanted, you can authorize it.

To authorize adware and PUAs for use:

1. On the Configure menu, point to Anti-virus, and then click Authorization.
2. On the Adware or PUAs tab, in the Known adware or PUAs list, select the adware or PUA.
3. Click Add.

The adware or PUA appears in the Authorized adware or PUAs list.

Note: You can also authorize adware and PUAs in Quarantine manager. For information on how
to do this, see Deal with adware and PUAs in quarantine (page 32).

Block authorized adware and PUAs

To prevent currently-authorized adware and PUAs from running on your computer:

1. On the Configure menu, point to Anti-virus, and then click Authorization.

2. On the Adware or PUAs tab, in the Authorized adware or PUAs list, select the adware or PUA
you want to block.
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3. Click Remove.

Authorize suspicious items for use
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

If you want to allow an item that Sophos Anti-Virus has classified as suspicious, you can authorize
it as follows.

. On the Configure menu, point to Anti-virus, and then click Authorization.
. Click the tab for the type of item that has been detected (for example, Buffer overflow).

1
2
3. In the Known list, select the suspicious item.
4. Click Add.

The suspicious item appears in the Authorized list.

Note: You can also authorize suspicious items in Quarantine manager. For information on how
to do this, see the following topics:

m Deal with suspicious files in quarantine (page 33)

m Deal with suspicious behavior in quarantine (page 34)

Pre-authorize suspicious items

If you want to allow an item that Sophos Endpoint Security and Control has not yet classified as
suspicious, you can pre-authorize it.

To pre-authorize a suspicious item:

1. On the Configure menu, point to Anti-virus, and then click Authorization.

2. Click the tab for the type of item that has been detected (for example, Buffer overflow).

3. Click New entry.
4

. Locate the suspicious item, and then double-click it.

The suspicious item appears in the Authorized list.
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5 Using Sophos Device Control

5.1

5.2

5.3

About device control on this computer
If a management console is not used to administer Sophos Endpoint Security and Control on this
computer, the device control functionality is not included.

Device control is enabled or disabled by a management console. If device control is enabled, it
might prevent you from connecting a device to this computer for maintenance or troubleshooting.
If this is the case, you can temporarily disable device control on this computer. For information,
see Temporarily disable device control (page 38).

What types of device are controlled?

Device control blocks or allows three types of device on this computer: storage, network, and short
range.

Storage

m Removable storage devices (for example, USB flash drives, PC Card readers, and external hard
disk drives)

m Optical media drives (CD-ROM/DVD/Blu-ray drives)
m Floppy disk drives

Network
m Modems
m Wireless (Wi-Fi interfaces, 802.11 standard)

The device control policy for this computer may be in Block bridged mode, which disables wireless
or modem network adapters when the computer is connected to a physical network (typically
through an Ethernet connection). Once the computer is disconnected from the physical network,
the wireless or modem network adapters are seamlessly re-enabled.

Short range
m Bluetooth interfaces

m Infrared (IrDA infrared interfaces)

Temporarily disable device control

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.
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5.4

5.5

If you are a member of the SophosAdministrator group and you want to connect a device to this
computer for maintenance or troubleshooting (for example, to install software from a CD), you
can temporarily disable device control.

To disable device control on this computer:

1. On the Configure menu, click Device control.
2. Clear the Enable Sophos Device Control check box.

Configure the device control log

1. On the Configure menu, click Device control.

2. Under Logging level, select one of the options:

m Click None to stop anything being logged.
m Click Normal to log summary information, error messages, and so on.

m (Click Verbose to provide information on many more activities than usual. Use this setting
only when you need detailed logging for troubleshooting, since the log will grow in size
rapidly.

3. Under Log archiving, follow the instructions on the screen.

View the device control log

[On the Home page, under Device control, click View device control log.
For information about the Home page, see About the Home page (page 4).

From the log page, you can copy the log to the clipboard, or email, or print the log.

To find specific text in the log, click Find and enter the text you want to find.
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6.1

6.2

6.3

Using Sophos Data Control

About data control on this computer
If a management console is not used to administer Sophos Endpoint Security and Control on this
computer, the data control functionality is not included.

Data control is enabled or disabled by a policy issued by a management console. However, if you
are a member of the SophosAdministrator group, you can temporarily disable data control on
this computer for maintenance or troubleshooting. For information, see Temporarily disable data
control (page 40).

Temporarily disable data control
Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

If you are a member of the SophosAdministrator group, you can temporarily disable data control
on this computer for maintenance or troubleshooting:

1. On the Configure menu, click Data control.
2. Clear the Enable Sophos Data Control check box.

How do | add a file to a storage device?

If data control is enabled on this computer, the data control policy may block any attempt to add
a file to a monitored storage device using the following methods:

m Saving data from within a program

m Using the DOS copy command

m Creating a new file on the device using Windows Explorer

If you see a desktop alert that warns you about this, you should save the file to your hard disk or
to a network drive, and then use Windows Explorer to copy it to the storage device.

6.4 Configure the data control log

1. On the Configure menu, click Data control.

2. Under Logging level, select one of the options:

m Click None to stop anything being logged.
m Click Normal to log summary information, error messages, and so on.
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m Click Verbose to provide information on many more activities than usual. Use this setting
only when you need to test new data control rules, since the log will grow in size rapidly.

3. Under Log archiving, follow the instructions on the screen.

6.5 View the data control log

[QOn the Home page, under Data control, click View data control log.
For information about the Home page, see About the Home page (page 4).

From the log page, you can copy the log to the clipboard, or email, or print the log.

To find specific text in the log, click Find and enter the text you want to find.
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7 Using Sophos Client Firewall

7.1 Getting started with the firewall

When the firewall is first installed, you may need to configure it. Whether you need to do this
depends on how it has been installed. There are two types of installation:

m [Installed on a network computer and managed from a management console
m [nstalled on a standalone computer and managed from the computer
Firewall managed from a management console

If the firewall is installed and managed from a management console, it allows or blocks applications
and traffic according to rules set by policy.

Unless the policy has put the firewall into interactive mode (see below), you will not be prompted
with any messages and do not need to configure the firewall in any way.

Firewall managed from this computer

If the firewall is managed on this computer, we recommend that you start by creating rules to
allow network access for common applications and services such as Web browsers and email
clients.

For information on creating rules, see About configuring the firewall (page 43).

The firewall will also initially be in interactive mode (see below). Leave the firewall in interactive
mode for a period of time so that you can allow or block other applications and services you use.

Once you have configured the firewall, and it recognizes the applications you commonly use, we
recommend that you change to one of the non-interactive modes.

For information, see Change to a non-interactive mode (page 48).
What's interactive mode?

In interactive mode, the firewall prompts you to allow or block any applications and traffic for
which it does not have a rule.

For information about how to deal with messages from the firewall, see About interactive mode
(page 48).
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7.2

7.2.1

7.2.2

7.2.3

Configuring the firewall

About configuring the firewall

You can configure the firewall in many different ways and then enable it. However, if a management
console is used to administer Sophos Endpoint Security and Control on this computer, it may
override any changes you make.

A few common functions are listed below:

Enable interactive mode (page 48)

Filter ICMP messages (page 46)

m  Allow LAN traffic (page 45)

m  Allow FTP downloads (page 44)

m Create a global rule (page 53)

m Allow an application (page 46)

m  Allow applications to launch hidden processes (page 57)
m  Allow applications to use rawsockets (page 58)

m  Use checksums to authenticate applications (page 58)

Temporarily disable the firewall
If you are a member of the SophosAdministrator group, you may need to temporarily disable the
firewall for maintenance or troubleshooting, and then re-enable it.

Sophos Endpoint Security and Control retains the settings you make here, even after you restart
your computer. If you disable the firewall, your computer is unprotected until you re-enable it.

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, select the Allow all traffic check box next to the primary or secondary
location.

Allow email

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).
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2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Applications tab.
4. Click Add, locate the email application, and then double-click it.

The email application is allowed as a trusted application.

Trusted applications are allowed full and unconditional network access, including access to the
internet. For greater security, you can apply the preset rules supplied by Sophos:

1. In the list of allowed applications, click the email application.
2. Click Custom > Add rules from preset > Email Client.

7.2.4 Allow the use of a web browser

Note: If you allow the use of a web browser, you also allow FTP access.
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).
2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Applications tab.
4. Click Add, locate the web browser application, and then double-click it.

The web browser application is allowed as a trusted application.

Trusted applications are allowed full and unconditional network access, including access to the
internet. For greater security, you can apply the preset rules supplied by Sophos:

1. In the list of allowed applications, click the web browser application.
2. Click Custom > Add rules from preset > Browser.

7.2.5 Allow FTP downloads

Note: If you have allowed the use of a web browser which can access FTP servers, you do not need
to allow FTP downloads as well.

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Applications tab.
4. Click Add, locate the FTP application, and then double-click it.

The FTP application is allowed as a trusted application.

Trusted applications are allowed full and unconditional network access, including access to the
internet. For greater security, you can apply the preset rules supplied by Sophos:
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1.
2.

In the list of allowed applications, click the FTP application.
Click Custom > Add rules from preset > FTP Client.

7.2.6 Allow LAN traffic

7.2.7

Note: If you allow traffic on a LAN, you also allow file and printer sharing on it.

To allow all traffic between the computers on a LAN:

1.

On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. On the LAN tab, do one of the following:

m Click Detect to detect the LAN that your computer is on and add it to the list of network
addresses.

m Click Add. In the Select address dialog box, select the Address format, type the domain
name or [P address, and then click Add.

4. Click OK to close the Select address dialog box.

. In the list of network addresses, select the Trusted check box for a LAN to allow traffic on it.

Allow file and printer sharing on a LAN

Note: If you have allowed traffic on a LAN, you do not need to allow file and printer sharing as
well.

1.

On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. On the LAN tab, do one of the following:

m Click Detect to detect the LAN that your computer is on and add it to the list of network
addresses.

m (Click Add. In the Select address dialog box, select the Address format, type the domain
name or IP address, and then click Add.

4. Click OK to close the Select address dialog box.
5. In the list of network addresses, select the NetBIOS check box for a LAN to allow file and

printer sharing on it.
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7.2.8

7.2.9

7.2.10

46

Allow an application

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Applications tab.
4. Click Add, locate the application, and then double-click it.

The application is allowed as trusted.

Trusted applications are allowed full and unconditional network access, including access to the
internet. For greater security, you can apply one or more application rules to specify the conditions
under which the application can run.

m Create an application rule (page 55)

m Apply preset application rules (page 55)

Block an application

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Applications tab.
If the application is not in the list, click Add, locate the application, and then double-click it.

DA

Select the application in the list, and then click Block.

Filter ICMP messages

Internet Control Message Protocol (ICMP) messages allow the computers on a network to share
error and status information. You can allow or block specific types of incoming or outgoing ICMP
message.

You should only filter ICMP messages if you are familiar with networking protocols. For
explanations of the ICMP message types, see Explanation of ICMP message types (page 47).

To filter ICMP messages:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the ICMP tab, select the In or Out check box to allow incoming or outgoing messages of
the specified type.
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Echo Request, Echo Reply

Destination Unreachable,
Echo Reply

Source Quench

Redirect

Router Advertisement,
Router Solicitation

Time Exceeded for a
Datagram

Parameter Problem for a
Datagram

Timestamp Request,
Timestamp Reply

Information Request,
Information Reply

Address Mask Request,
Address Mask Reply

7.2.11 Explanation of ICMP message types

Used to test destination accessibility and status. A host sends an
Echo Request and listens for a corresponding Echo Reply. This
is most commonly done using the pi ng command.

Sent by a router when it cannot deliver an IP datagram. A
datagram is the unit of data, or packet, transmitted in a TCP/IP
network.

Sent by a host or router if it is receiving data too quickly for it to
handle. The message is a request that the source reduce its rate
of datagram transmission.

Sent by a router if it receives a datagram that should have been
sent to a different router. The message contains the address to
which the source should direct future datagrams. This is used to
optimize the routing of network traffic.

Allow hosts to discover the existence of routers. Routers
periodically broadcast their IP addresses via Router
Advertisement messages. Hosts may also request a router address
by broadcasting a Router Solicitation message to which a router
will reply with a Router Advertisement.

Sent by a router if the datagram has reached the maximum limit
of routers through which it can travel.

Sent by a router if a problem occurs during the transmission of
a datagram such that it cannot complete processing. One potential
source of such a problem is invalid datagram header.

Used to synchronize the clocks between hosts and to estimate
transit time.

Obsolete. These messages were used earlier by hosts to determine
their inter-network addresses, but are now considered outdated
and should not be used.

Used to find the mask of the subnet (i.e. what address bits define
the network). A host sends an Address Mask Request to a router
and receives an Address Mask Reply in return.

7.2.12 Restore the firewall default settings

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).
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2. Under Managing configuration, click Restore defaults.

7.3 Working in interactive mode

7.3.1 About interactive mode

In interactive mode, the firewall displays a learning dialog each time an unknown application or
service requests network access. The learning dialog asks you whether to allow the traffic once,
block it once, or whether to create a rule for that type of traffic.

In interactive mode, you will see the following types of learning dialog:
m  Hidden process learning dialogs (page 49)

m  Protocol learning dialogs (page 49)

m Application learning dialogs (page 49)

m  Rawsocket learning dialogs (page 50)

m  Checksum learning dialogs (page 50)

7.3.2 Enable interactive mode

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the General tab, under Working mode, click Interactive.

7.3.3 Change to a non-interactive mode

There are two non-interactive modes:
m Allow by default
m Block by default

In the non-interactive modes, the firewall deals with network traffic automatically using your
rules. Network traffic which has no matching rule is either all allowed or all blocked.

To change to a non-interactive mode:

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. On the General tab, under Working mode, click Allow by default or Block by default.
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7.3.4

7.3.5

7.3.6

7.3.7

Hidden process learning dialogs

A hidden process is when one application launches another one to perform some network access
for it. Malicious applications sometimes use this technique to evade firewalls: they launch a trusted
application to access the network rather than doing it themselves.

The hidden process learning dialog displays information about the hidden process and the
application that launched it.

m Enable hidden process learning dialogs (page 49)

Enable hidden process learning dialogs
If you are using interactive mode, the firewall can display a learning dialog when it detects a new
launcher.

If you are using interactive mode and this option is not selected, new launchers are blocked from
launching hidden processes.

To enable hidden process learning dialogs:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Processes tab.

4. Select the Warn about new launchers check box.

Protocol learning dialogs
If the firewall detects network activity by the system that it cannot relate to a specific application,
it prompts for the creation of a protocol rule.

The protocol learning dialog displays information about the unrecognized network activity, i.e.
the protocol and remote address.

Application learning dialogs

If the firewall detects an application attempting to access the network in a way that is not covered
by any existing rule, it prompts for the creation of an application rule.

The application learning dialog displays information about the unrecognized network activity,
i.e. the remote service and the remote address.
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7.3.8

7.3.9

7.3.10
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Rawsocket learning dialogs
Rawsockets allow processes to control all aspects of the data they send over the network and can
be used for malicious purposes.

If the firewall detects a rawsocket attempting to access the network in a way that is not covered by
any existing rule, it prompts for the creation of a rawsocket rule.

The rawsocket learning dialog displays information about the rawsocket.

m Enable rawsocket learning dialogs (page 50)

Enable rawsocket learning dialogs
If you are using interactive mode, the firewall can display a learning dialog when it detects a
rawsocket attempting to access the network in a way that is not covered by any existing rule.

If you are using interactive mode and this option is not selected, rawsockets are blocked from
accessing the network.

To enable rawsocket learning dialogs:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Processes tab.

4. Select the Warn about the use of rawsockets check box.

Checksum learning dialogs

If the firewall detects a new or modified application, it displays a checksum learning dialog.

If you want to allow the application to access the network, you must add its checksum (a unique
identifier) to the list of recognized checksums.

Select one of the following options:

m Add the checksum to existing checksums for this application allows multiple versions of this
application.

m Replace any existing checksum for this application replaces all existing checksums for the
application with the one requesting access, and thereby allows only the latest version of this
application.

m Block this application until it is restarted blocks the application on this occasion.
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7.3.11

7.4

7.4.1

7.4.2

7.4.3

Enable checksum learning dialogs
If you are using interactive mode, the firewall can display a learning dialog when it detects a new
or modified application.

If you are using interactive mode and this option is not selected, applications are blocked from
accessing the network.

To enable checksum learning dialogs:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. Select the Use checksums to authenticate applications check box.

Firewall configuration files

About firewall configuration files

Sophos Client Firewall enables you to export the firewall general settings and rules as a configuration
file. You can use this feature to do the following:

m Back up and restore your entire firewall configuration.

m Save a general settings configuration and install it on multiple computers.

m Create rules for applications on one computer and export them for use on other computers
running the same set of applications.

m  Use the management console to merge configurations created on several different computers
to create a policy that is valid for all computers on the network.

Export a firewall configuration file

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Click Export.

3. Give your configuration file a name and location, and then click Save.

Import a firewall configuration file

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).
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7.5

7.5.1

7.5.2

52

2. Click Import.
3. Select a configuration file and click Open.

4. Follow the instructions on the screen.

Firewall rules

About firewall rules

Global rules

Global rules apply to all network communications and to applications even if they have application
rules.

Application rules

You can have one or more rules for an application. You can either use preset rules created by
Sophos or create custom rules to give you fine control over the access allowed for an application.

About the order in which rules are applied

For connections that use rawsockets, only the global rules are checked.
For connections that do not use rawsockets, various rules are checked in the following order.

1. If the connection is to an address in one of the ranges specified on the LAN tab, and the address
has been marked as trusted, the connection is allowed with no further checks.

2. If the network only allows NetBIOS, any connection that meets the following criteria is allowed:
m Any TCP connection where the remote port is in the range 137-139 or 445.
m Any TCP connection where the local port is in the range 137-139 or 445.
m Any UDP connection where the remote port is 137 or 138.

m Any UDP connection where the local port is 137 or 138.

3. Any NetBIOS traffic that has not been allowed using the LAN tab is blocked. For information
on how to allow NetBIOS traffic, see Allow file and printer sharing on a LAN (page 45).

4. The high priority global rules are checked, in the order in which they are listed.

5. If the connection has not already had rules applied to it, the firewall checks the application
rules.

6. If the connection has still not been handled, the firewall will apply the normal priority global
rules, in the order in which they are listed.

7. If no rules have been found to handle the connection:
m In Allow by default mode, the traffic is allowed.
m In Block by default mode, the traffic is blocked.
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7.5.3

7.5.3.1

7.5.3.2

m In Interactive mode, the user is asked to decide.

Global rules

Create a global rule

Important: We recommend that you create global rules only if you are familiar with networking
protocols.

Global rules apply to all network communications and to applications which do not already have
arule.

To create a global rule:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Global Rules tab.
Click Add.

Under Rule name, type a name for the rule.

A

The rule name must be unique within the list of rules. Two global rules cannot have the same
name.

6. To apply the rule before any application rules or normal priority global rules, select the High
priority rule check box.
For more information on the order in which rules are applied, see About the order in which
rules are applied (page 52).

7. Under Select the events the rule will handle, select the conditions that the connection must
match for the rule to apply.

8. Under Select the actions with which the rule will respond, select either Allow it or Block it.

9. To intelligently allow replies from the remote computer based on the initial connection, select
Stateful inspection.

10. Under Rule description, click an underlined value. For example, if you click the TCP link, the
Select Protocol dialog box opens.

Change a global rule

Important: We recommend that you change global rules only if you are familiar with networking
protocols.

To change a global rule:

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).
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7.5.3.3

7.5.3.4
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9.

SR S

Under Configurations, click Configure next to the location that you want to configure.
Click the Global Rules tab.

In the Rule list, select the rule that you want to edit.

Click Edit.

Under Rule name, type a name for the rule.

The rule name must be unique within the list of rules. Two global rules cannot have the same
name.

To apply the rule before any application rules or normal priority global rules, select the High
priority rule check box.

For more information on the order in which rules are applied, see About the order in which
rules are applied (page 52).

Under Select the events the rule will handle, select the conditions that the connection must
match for the rule to apply.

Under Select the actions with which the rule will respond, select either Allow it or Block it.

10. To intelligently allow replies from the remote computer based on the initial connection, select

Stateful inspection.

11. Under Rule description, click an underlined value. For example, if you click the TCP link, the

Select Protocol dialog box opens.

Copy a global rule

To copy a global rule and append it to the list of rules:

1.

DA

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Global Rules tab.

In the Rule list, select the rule that you want to copy.

Click Copy.

Change the order in which global rules are applied

Global rules are applied in the order in which they appear from top to bottom in the list of rules.

To change the order in which the global rules are applied:

1.

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. Click the Global Rules tab.

In the Rule list, click the rule that you want to move up or down in the list.
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5.

Click Move Up or Move Down.

7.5.3.5 Delete a global rule

7.5.4

7.5.4.1

7.5.4.2

1.

oo LD

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Global Rules tab.

In the Rule list, select the rule that you want to delete.

Click Remove.

Application rules

Apply preset application rules

A preset is a set of application rules created by Sophos. To append preset rules to the list of rules
for an application:

1.

oo LD

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Applications tab.
Select the application in the list, and then click the arrow next to Custom.

Point to Add rules from preset, and then click a preset.

Create an application rule

To create a custom rule which allows fine control over the access allowed for an application:

1.

On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. Click the Applications tab.

Select the application in the list, and then click Custom.

You can also double-click the application in the list.

5. In the Application Rules dialog box, click Add.

6. Under Rule name, type a name for the rule.

The rule name must be unique within the list of rules. Two application rules cannot have the
same name, but two applications can each have a rule with the same name.

Under Select the events the rule will handle, select the conditions that the connection must
match for the rule to apply.
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8. Under Select the actions with which the rule will respond, select either Allow it or Block it.

9. To intelligently allow replies from the remote computer based on the initial connection, select

Stateful inspection.

10. Under Rule description, click an underlined value. For example, if you click the TCP link, the

Select Protocol dialog box opens.

Change an application rule

1.

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. Click the Applications tab.

Select the application in the list, and then click Custom.

You can also double-click the application in the list.

5. In the Application Rules dialog box, click Edit.

6. Under Rule name, type a name for the rule.

The rule name must be unique within the list of rules. Two application rules cannot have the
same name, but two applications can each have a rule with the same name.

Under Select the events the rule will handle, select the conditions that the connection must
match for the rule to apply.

8. Under Select the actions with which the rule will respond, select either Allow it or Block it.

9. To intelligently allow replies from the remote computer based on the initial connection, select

Stateful inspection.

10. Under Rule description, click an underlined value. For example, if you click the TCP link, the

Select Protocol dialog box opens.

Copy an application rule

To copy an application rule and append it to the list of rules:

1.

On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.

3. Click the Applications tab.

Select the application in the list, and then click Custom.

You can also double-click the application in the list.

In the Application Rules dialog box, click Copy.
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Change the order in which application rules are applied

Application rules are applied in the order in which they appear from top to bottom in the list of
rules.

To change the order in which the application rules are applied:

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).
2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Applications tab.
4. Select the application in the list, and then click Custom.
You can also double-click the application in the list.
5. In the Rule list, click the rule that you want to move up or down in the list.

6. Click Move Up or Move Down.

Delete an application rule

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

Under Configurations, click Configure next to the location that you want to configure.
Click the Applications tab.

Select the application in the list, and then click Custom.

oo LD

In the Application Rules dialog box, click Remove.

Allow applications to launch hidden processes

An application sometimes launches another hidden process to perform some network access for
it.

Malicious applications can use this technique to evade firewalls: they launch a trusted application
to access the network rather than doing so themselves.

The firewall sends an alert to the management console, if one is being used, the first time a hidden
process is detected.

To allow applications to launch hidden processes:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Processes tab.
4. In the upper area, click the Add button.
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5. Locate the application, and then double-click it.

If you are using interactive mode, the firewall can display a learning dialog when it detects a new
launcher.

m Enable interactive mode (page 48)

m Enable hidden process learning dialogs (page 49)

Allow applications to use rawsockets

Some applications can access a network through rawsockets, which gives them control over all
aspects of the data they send over the network.

Malicious applications can exploit rawsockets by faking their IP address or send deliberately
corrupt messages.

The firewall sends an alert to the management console, if one is being used, the first time a rawsocket
is detected.

To allow applications to access the network through rawsockets:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Processes tab.

4. In the lower area, click the Add button.

5. Locate the application, and then double-click it.

If you are using interactive mode, the firewall can display a learning dialog when a rawsocket is
detected.

m Enable interactive mode (page 48)

m Enable rawsocket learning dialogs (page 50)

Use checksums to authenticate applications

Each version of an application has a unique checksum. The firewall can use this checksum to
decide whether an application is allowed or not.

By default, the firewall checks the checksum of each application that runs. If the checksum is
unknown or has changed, the firewall blocks it or (in interactive mode) asks the user what to do.

The firewall also sends an alert to the management console, if one is being used, the first time a
new or modified application is detected.

To add a checksum to the list of allowed checksums:

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).
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2. Under Configurations, click Configure next to the location that you want to configure.
3. Click the Checksums tab.

4. Click Add.
5

. Locate the application, and then double-click it.

If you are using interactive mode, the firewall can display a learning dialog when it detects a new
or modified application.

m Enable interactive mode (page 48)

m Enable hidden process learning dialogs (page 49)

Location awareness

About location awareness
Location awareness is a feature of Sophos Client Firewall which assigns sets of rules based on the
location of the computer.

A laptop may, for example, be assigned a more restrictive set of firewall rules when it is being used
out of the office, since it will not have the added protection of the network firewall.

To use location awareness, you first define a list of your primary locations (for example, your
various office networks). When the firewall detects that you are connected to one of your primary
locations, it uses your primary configuration.

m  Define your primary locations (page 59)

Next, you create a secondary configuration. If the firewall detects that you are not connected to
one of your primary locations, it uses your secondary configuration.

m Create a secondary configuration (page 60)

Define your primary locations

The firewall uses your primary configuration when it detects that you are in one of your primary
locations.

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Click the Location detection tab.
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3. Under Detection method, click Configure next to the method that you want to use to define
your primary locations:

Option Description

DNS lookup You create a list of domain names and expected IP addresses that
correspond to your primary locations.

MAC address detection You create a list of gateway MAC addresses that correspond to your
primary locations.

In both cases, the firewall examines or resolves your list of primary locations. If it finds a
successful match, your computer is taken to be in one of your primary locations.

4. Follow the instructions on the screen.

Create a secondary configuration

The firewall uses your secondary configuration when it detects that you are not connected to your
primary location.

1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Select the Add configuration for a second location check box.

Now set up your secondary configuration. For information, refer to the Configuring the firewall
section.

Firewall reporting

About firewall reporting

By default, the firewall reports state changes, events, and errors to the management console.
Firewall state changes

The firewall regards the following as state changes:

m Changes to the working mode

m Changes to the software version

m Changes to whether the firewall is configured to allow all traffic

m Changes to whether the firewall complies with policy

When you are working in interactive mode, your firewall configuration may deliberately differ
from the policy applied by the management console. In that case, you can choose not to send
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"differs from policy" alerts to the management console when you make changes to certain parts
of your firewall configuration.

For more information, see Turn reporting of local changes on or off (page 61).
Firewall events

An event is when an unknown application on your computer, or your computer's operating system,
tries to communicate with another computer over a network connection.

You can prevent the firewall from reporting events to the management console.

For more information, see Turn off reporting of unknown network traffic (page 61)

Turn reporting of local changes on or off

If your firewall configuration differs from policy, you can turn reporting of local changes off.

Turning reporting of local changes off stops the firewall sending "differs from policy" alerts to the
management console about changes made to the global rules, applications, processes, or checksums.
You may want to do this, for example, when you are working in interactive mode, since these are
settings that can be changed by using the learning dialogs.

If the firewall configuration on this computer is intended to conform to policy, you should turn
reporting of local changes on.

To turn reporting of local changes off:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the General tab, under Reporting, clear the Display an alert in the management console
if local changes are made to the global rules, applications, processes or checksums check box
to turn reporting of local changes off.

To turn reporting of local changes on, select the check box.

Turn off reporting of unknown network traffic
You can prevent the firewall from reporting unknown network traffic to the management console.
The firewall regards traffic as unknown if there is no rule for it.
To prevent the firewall from reporting unknown network traffic to the management console:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the General tab, under Blocking, select the Use checksums to authenticate applications
check box.
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4. Under Reporting, clear the Report unknown applications and traffic to the management
console check box.

Turn off reporting of firewall errors
Important: We do not recommend that you turn off reporting of firewall errors permanently.
You should turn off reporting only when you need to.
To prevent the firewall from reporting errors to the management console:
1. On the Home page, under Firewall, click Configure firewall.
For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the General tab, under Reporting, clear the Report errors to the management console
check box.

Configure desktop messaging

You can control what messages the firewall displays on the desktop using balloon tips.

Unknown applications and traffic balloon tips are not shown in interactive mode since the same
information is displayed in the learning dialogs.

1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).

2. Under Configurations, click Configure next to the location that you want to configure.

3. On the General tab, under Desktop messaging, do one of the following:

m To display balloon tips for firewall warnings and errors, select the Show warnings and
errors check box.

m To display balloon tips for unknown applications and traffic, select the Show unknown
applications and traffic check box.

Firewall logging

About the firewall log viewer

The Sophos Client Firewall log viewer enables you to view, filter, and save details of the following:
m All connections
m Connections that have been allowed or blocked

m Firewall events
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m The system log

7.8.2 Open the firewall log viewer

[ QOn the Home page, under Firewall, click View Firewall log.
For information about the Home page, see About the Home page (page 4).

7.8.3 Configure firewall logging

To manage the size and contents of the firewall's event log database:
1. On the Home page, under Firewall, click Configure firewall.

For information about the Home page, see About the Home page (page 4).
2. Click the Log tab.

3. To manage the size of the firewall's event log database, select one of the following options:

Option Description

To allow the database to grow without limit | Click Keep all records.

To clear out old records Click Delete old records, and then configure the Log
cleanup settings.

4. Under Log cleanup settings, select one or more of the following options:

m Click the Delete records after check box and enter or select a figure in the Days box.
m (Click the Keep no more than check box and enter or select a figure in the Records box.
m Click the Keep size under check box and enter or select a figure in the MB box.

7.8.4 Change how the firewall log viewer looks

1. On the Home page, under Firewall, click View firewall log.
For information about the Home page, see About the Home page (page 4).

2. On the View menu, click Layout.
3. In the Customize View dialog box, select items to hide or display:
The Console tree is displayed in the left pane.

The Toolbar is displayed at the top of the firewall log viewer.
The Description bar is displayed above the data in the right pane.

The Status bar is displayed at the bottom of the firewall log viewer.
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7.8.5 Customize the data format

You can change the format used to display the following items of data in the firewall logs:
m Display ports as a number or a name, for example HTTP or 80.
m Display applications as icons, file paths, or both.

m Specify the size of unit that is used to display the data transfer speed, for example KBytes or
MBytes.

m Hide or display the gridlines.
To customize the data format:
1. On the Home page, under Firewall, click View firewall log.
For information about the Home page, see About the Home page (page 4).

2. On the View menu, click Customize.

3. Select the options you want.

7.8.6 Hide or display columns in the firewall log viewer

1. On the Home page, under Firewall, click View firewall log.
For information about the Home page, see About the Home page (page 4).

2. Click an item in the console tree that displays columns in the details pane.
3. On the View menu, select Add/Remove Columns.

You can also right-click any of the column headings.

4. In the Columns dialog box, do the following:

Option Description

To hide a column Clear its check box.

To display a column Select its check box.

7.8.7 Reorder columns in the firewall log viewer

1. On the Home page, under Firewall, click View firewall log.
For information about the Home page, see About the Home page (page 4).

2. Click an item in the console tree that displays columns in the details pane.
3. On the View menu, select Add/Remove Columns.

You can also right-click any of the column headings.
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4.

In the Columns dialog box, click a column name, and then click Move Up or Move Down to
change the position of the column.

Notes

You can also reorder columns in the details pane by using a mouse to drag a column heading
to the left or right of its original position. As you drag a column, highlighting between the
column headings indicates the new position of the column.

You can resize columns by using the mouse to drag column headings.

Filter records in a firewall log

You can sort the firewall log records by creating a filter.

To filter the firewall log records:

1.

On the Home page, under Firewall, click View firewall log.

For information about the Home page, see About the Home page (page 4).

In the console tree, select a log.

3. On the Action menu, click Add filter.

4.

Follow the rest of the instructions in the Rules wizard.

The filter appears in the console tree immediately below the node for the log you want to filter.

Export all records from a firewall log

To export all the records from the firewall log to a text or CSV file:

1.

AR

On the Home page, under Firewall, click View firewall log.
For information about the Home page, see About the Home page (page 4).

In the console tree, select a log.
Right-click the record list, and then click Export All Records.
In the File name box, type a name for the file.

In the Save as type list, click the file type that you want.

Export selected records from a firewall log

To export selected records from a firewall log to a text or CSV file:

1.

2.

On the Home page, under Firewall, click View firewall log.

For information about the Home page, see About the Home page (page 4).

In the console tree, select a log.
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3. Select the records you want to export.

If the records update rapidly, on the View menu, clear the Auto refresh check box.

4. On the Action menu, click Export Selected Records.
5. In the File name box, type a name for the file.

6. In the Save as type list, click the file type that you want.
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8.1

8.2

8.3

Using Sophos AutoUpdate

Update immediately

By default, Sophos AutoUpdate is scheduled to update every 5 minutes if you are permanently
connected to your company network, or every 60 minutes if you are permanently connected to
the internet.

If you are on a dial-up connection, Sophos AutoUpdate is scheduled to update when you connect
to the internet or your network, and every 60 minutes after that.

To update immediately:

[Right-click the Sophos Endpoint Security and Control system tray icon, and then click Update
now.

Schedule updates

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

You can specify when or how often Sophos AutoUpdate updates.

1. On the Configure menu, click Updating.
2. Click the Schedule tab.

3. Select Enable automatic updates, and then enter the frequency (in minutes) with which
Sophos AutoUpdate will update.

If the updated files are downloaded from your company network, updates are every 5 minutes
by default.

If the updated files are downloaded over the internet from the Sophos server,
Sophos AutoUpdate cannot update more frequently than every 60 minutes.

Set a source for updates

If you want Sophos AutoUpdate to update automatically, you must specify where it downloads
updates from.

1. On the Configure menu, click Updating.
2. Click the Primary location tab.
3. In the Address list, enter the UNC path or web address of the update server.

To download updates directly from Sophos via the internet, select Sophos in the Address list.
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In the User name box, type the User name for the account that will be used to access the update
server.

If the User name needs to be qualified to indicate the domain, use the form domain\username.

In the Password box, type and confirm the Password.

8.4 Set an alternative source for updates

8.5

8.6

You can set an alternative source for updates. If Sophos AutoUpdate cannot update from its usual
source, it will attempt to update from the alternative source.

1. On the Configure menu, click Updating.

Click the Secondary location tab.

3. In the Address list, enter the UNC path or web address of the update server.

To download updates directly from Sophos via the internet, select Sophos in the Address list.

In the User name box, type the User name for the account that will be used to access the update
server.

If the User name needs to be qualified to indicate the domain, use the form domain\username.

In the Password box, type and confirm the Password.

Update via a proxy server

If Sophos AutoUpdate updates via the internet, you must enter details of any proxy server that it
must use to connect to the internet.

AN

On the Configure menu, click Updating.

Click the Primary location or Secondary location tab.

Click Proxy Details.

Select the Access the location via a proxy check box.

Enter the proxy server Address and Port number.

Enter a User name and Password that grant access to the proxy server.

If the user name needs to be qualified to indicate the domain, use the form domain\username.

Update via a dial-up connection

To update via a dial-up connection to the internet:

1.
2.
3.

On the Configure menu, click Updating.
Click the Schedule tab.
Select Check for updates on dial-up.
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Sophos AutoUpdate will update whenever you connect to the internet.

8.7 Limit the bandwidth used for updating

To prevent Sophos AutoUpdate from using all your bandwidth when you need it for other purposes
(such as downloading your email), you can limit the amount of bandwidth it uses.

1. On the Configure menu, click Updating.

2. Click the Primary location or Secondary location tab.
3.
4

. Select the Limit amount of bandwidth used check, and move the slider to specify the amount

Click Advanced.

of bandwidth Sophos AutoUpdate uses.

Note: If you specify more bandwidth than is available, Sophos AutoUpdate uses all the
bandwidth.

8.8 Log updating activity

You can configure Sophos AutoUpdate to record updating activity in a log file.

M

On the Configure menu, click Updating.

Click the Logging tab.

Select the Log Sophos AutoUpdate activity check box.

In the Maximum log size box, type or select the maximum size in MB for the log.
In the Log level list, select Normal or Verbose logging.

Verbose logging provides information on many more activities than usual, so the log will grow
faster. Use this option only when you need a detailed log for troubleshooting.

8.9 View the updating log file

1.
2.
3.

On the Configure menu, click Updating.
Click the Logging tab.
Click View Log File.
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Troubleshooting

Updating has failed

About update failures

To find out more about an update failure, look at the update log: for information on how to do
this, see View the updating log file (page 69).

The sections below explain why updating may fail, and how you can change the settings to correct
the problem.

Sophos Endpoint Security and Control contacts the wrong source for updates (page 70)

Sophos Endpoint Security and Control cannot use your proxy server (page 70)

Automatic updating is not correctly scheduled (page 70)

The source for updates is not being maintained (page 71)

Sophos Endpoint Security and Control contacts the wrong source for
updates

1. On the Configure menu, click Updating.

2. On the Primary location tab, check that the address and account details are those supplied by
your administrator.

For information on configuring the Primary location tab, see Set a source for updates (page
67).

Sophos Endpoint Security and Control cannot use your proxy server

If Sophos Endpoint Security and Control updates itself via the internet, you must make sure that
it can use your proxy server (if there is one).

1. On the Configure menu, click Updating.
2. On the Primary location tab, click Proxy Details.
3. Ensure that the proxy server address, the port number, and the account details are correct.

For information on entering proxy details, see Update via a proxy server (page 68).

Automatic updating is not correctly scheduled

1. On the Configure menu, click Updating.
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2. Click the Schedule tab. (For information on the Schedule tab, see Schedule updates (page 67).)

3. If your computer is networked, or if you update via a broadband internet connection, select
Enable automatic updates and enter the updating frequency. If you update via a dial-up
connection, select Check for updates on dial-up.

The source for updates is not being maintained
Your company may have moved the directory (on the network or on a web server) from which
you should update. Alternatively, they may not be maintaining the directory.

If you think this may be the case, contact your network administrator.

Threat not cleaned

If Sophos Anti-Virus has not cleaned a threat from your computer, it may be because of the
following.

Automatic cleanup is disabled

If Sophos Anti-Virus has not attempted cleanup, check that automatic cleanup has been enabled.
To enable automatic cleanup, see About cleanup (page 26) and the other topics in the Cleaning
up section. Automatic cleanup of adware and PUAs is not available for on-access scanning.

Cleanup failed

If Sophos Anti-Virus could not clean a threat ("Cleanup failed"), it may be that it cannot clean
that type of threat, or you have insufficient access rights.

Full computer scan is required

You may need to run a full computer scan to determine all components of a multi-component
threat, or to detect a threat in files that were previously hidden, before Sophos Anti-Virus can
clean it from your computer.

1. To scan all disk drives, including boot sectors, on the computer, run the Scan my computer
scan. For information, see Run a full computer scan (page 16).

2. If the threat has still not been fully detected, it may be because you have insufficient access
rights, or some drives or folders on the computer, containing the threat’s components, are
excluded from scanning. For information, see Exclude files, folders or drives from on-access
scanning (page 9). Check the list of the items excluded from scanning. If there are some items
on the list, remove them from the list and scan your computer again.

Removable medium is write-protected

If dealing with a removable medium (e.g. floppy disk, CD), make sure that it is not write-protected.
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NTFS volume is write-protected

If dealing with files on an NTFS volume (Windows 2000 or later), make sure that it is not
write-protected.

Virus/spyware fragment has been reported

Sophos Anti-Virus does not clean a virus/spyware fragment because it has not found an exact
virus/spyware match. Refer to Virus/spyware fragment reported (page 72).

Virus/spyware fragment reported

If a virus/spyware fragment is reported, do the following:

1. Update your protection immediately, so that Sophos Anti-Virus has the latest virus identity
files.
2. Run a full computer scan.

m  Update immediately (page 67)

®m  Run a full computer scan (page 16)

If virus/spyware fragments are still reported, contact Sophos technical support for advice.
m  Technical support (page 82)

The report of a virus/spyware fragment indicates that part of a file matches part of a virus or item
of spyware. There are three possible causes:

Variant of a known virus or item of spyware

Many new viruses or items of spyware are based on existing ones, so that code fragments typical
of a known virus or item of spyware may appear as part of a new one. If a virus/spyware fragment
is reported, it is possible that Sophos Anti-Virus has detected a new virus or item of spyware,
which could become active.

Corrupted virus

Many viruses contain bugs in their replication routines that cause them to infect target files
incorrectly. An inactive portion of the virus (possibly a substantial part) may appear within the
host file, and this is detected by Sophos Anti-Virus. A corrupted virus cannot spread.

Database containing a virus or item of spyware

When running a full scan, Sophos Anti-Virus may report that there is a virus/spyware fragment
in a database file. If this is the case, do not delete the database. Contact Sophos technical support
for advice.

For information about contacting technical support, see Technical support (page 82).
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Threat partially detected

To scan all disk drives, including boot sectors, on the computer, run a full computer scan.
®m  Run a full computer scan (page 16)

If the threat has still not been fully detected, it may be because some drives or folders on the
computer, containing the threat’s components, are excluded from scanning. If there are some of
these items on the exclusion list, remove them, and then scan your computer again.

m Exclude files, folders or drives from on-demand scanning (page 14)
If the threat has still not been fully detected, it may be because you have insufficient access rights.

Sophos Anti-Virus may not be able to fully detect or remove threats with components installed
on network drives.

Adware or PUA disappeared from quarantine

If an item of adware or PUA detected by Sophos Anti-Virus has disappeared from Quarantine
manager without you taking any action, the adware or PUA might have been authorized or cleaned
up from the management console or by another user. Check the list of authorized adware and
PUAs to see if it has been authorized. To find out how to do this, refer to Authorize adware and
PUAEs for use (page 36).

Computer becomes slow

If your computer has become very slow, it may be that you have a PUA running on and monitoring
your computer. If you have on-access scanning enabled, you may also see many desktop alerts
warning about a PUA. To solve the problem, do the following.

1. Run the Scan my computer scan to detect all components of the PUA. For information, see
Run a full computer scan (page 16).

Note: If after the scan the PUA is partially detected, refer to Threat partially detected (page
73), step 2.

2. Clean the adware or PUA from your computer. To find out how to do this, refer to Deal with
adware and PUAs in quarantine (page 32).

Unable to access disk with infected boot sector

Important: If a management console is used to administer Sophos Endpoint Security and Control
on this computer, it may override any changes you make here.

By default, Sophos Anti-Virus prevents access to removable disks whose boot sectors are infected.
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9.10
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To allow access (for example, to copy files from a floppy disk infected with a boot sector virus):

1. On the Configure menu, point to Anti-virus, and then click On-access scanning.

2. On the Scanning tab, select Allow access to drives with infected boot sectors check box.

Important: As soon as you have finished accessing the disk, clear the check box, and then remove
the disk from the computer so that it cannot try to re-infect the computer on restart.

Unable to access areas of Sophos Endpoint Security and Control
If you are unable to use or configure particular areas of Sophos Endpoint Security and Control it
might be because access to these areas is restricted to members of particular Sophos user groups.

For more information about Sophos user groups, see About Sophos groups (page 5).

Recovering from virus side-effects

Recovery from virus infection depends on how the virus infected the computer.

Virus side-effects

Some viruses leave you with no side-effects to deal with, others may have such extreme side-effects
that you have to restore a hard disk in order to recover.

Some viruses gradually make minor changes to data. This type of corruption can be hard to detect.

What to do

It is very important that you read the threat analysis on the Sophos website, and check documents
carefully after cleanup. Refer to Get cleanup information (page 29) to find out how to view details
on the Sophos website of the virus’s side-effects.

Sound backups are crucial. If you did not have them before you were infected, start keeping them
in case of future infections.

Sometimes you can recover data from disks damaged by a virus. Sophos can supply utilities for
repairing the damage caused by some viruses.

Contact Sophos technical support for advice.

For information about contacting technical support, see Technical support (page 82).

Recovering from adware and PUA side-effects

Removing adware and PUAs may have some side-effects that cannot be eliminated during cleanup.

Operating system has been modified

Some items of adware and PUAs modify the Windows operating system, for example, change your
internet connection settings. Sophos Anti-Virus cannot always restore all settings to the values
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they had before installation of the adware or PUA. If, for example, an item of adware or PUA
changed the browser home page, then Sophos Anti-Virus cannot know what the previous home
page setting was.

Utilities not cleaned

Some items of adware and PUAs can install utilities, such as .dll or .ocx files, on your computer.
If a utility is harmless (that is, it does not possess the qualities of adware and PUAs), for example,
a language library, and is not integral to the adware or PUA, Sophos Anti-Virus may not detect it
as part of the adware or PUA. In this case, the file is not removed from your computer even after
the adware or PUA that installed the file has been cleaned from the computer.

Adware or PUA is part of a program you need

Sometimes an item of adware or PUA is part of a program that you intentionally installed, and
needs to be there for the program to run. If you remove the adware or PUA, the program may
stop running on your computer.

What to do

It is very important that you read the threat analysis on the Sophos website. Refer to Get cleanup
information (page 29) to find out how to view details on the Sophos website of the adware or
PUA's side-effects.

To be able to recover your system and its settings to their previous state, you should maintain
regular backups of your system. You should also make backup copies of the original executable
files of the programs you want to use.

For more information or advice on recovering from adware and PUA side-effects, contact Sophos
technical support.

For information about contacting technical support, see Technical support (page 82).

Password error reported

If you are trying to schedule a custom scan, and an error message is displayed about the password,
make sure of the following:

m The password is correct for the user account

m The password is not blank

To make sure that the password is correct, check the properties of the user account in User
Accounts in Control Panel.
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9.12 "Service failure" error message
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Symptoms
You see one of the following error messages in the notification area:
m Anti-virus and HI PS: service failure

m Firewall: service failure

Causes

One of the Sophos Endpoint Security and Control services on your computer has failed, and needs
to be restarted.

Resolve the problem

1. Using Windows, open Services.
2. Do one of the following:

m IfyouseecanAnti-virus and H PS: service fail ure error message, right-click
Sophos Anti-Virus, and then click Restart.

m IfyouseeaFirewal | : service fail ure error message, right-click Sophos Client
Firewall Manager, and then click Restart.

Notes

m To open Services, click Start, click Control Panel, double-click Administrative Tools, and
then double-click Services.
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10 Glossary

adware and PUAs

application rule

Authorization
manager

automatic cleanup

blocked

buffer overflow
detection

checksum

cleanup

Content Control List
(CCL)

content rule

controlled application

Adware displays advertising, for example, pop-up messages, which
affects user productivity and system efficiency. A potentially unwanted
application (PUA) is an application that is not inherently malicious
but is generally considered unsuitable for the majority of business
networks.

A rule that applies only to packets of data transferred over the network
to or from a particular application.

The module that enables you to authorize adware and PUAs, suspicious
files, and applications that exhibit suspicious behavior and buffer
overflows.

Cleanup that is performed without any intervention or acceptance by
you.

A status showing that applications (including hidden processes),
connections, protocols, ICMP messages, and so on have been refused
network access.

Detects buffer overflow attacks.

Each version of an application has a unique checksum. The firewall
can use this checksum to decide whether an application is allowed or
not.

Cleanup eliminates threats on your computer by removing a virus
from a file or boot sector, moving or deleting a suspicious file, or
deleting an item of adware or PUA. However, it does not undo any
actions the threat has already taken. It is not available for threats that
are detected by web page scanning because the threats are not
downloaded to your computer. Therefore, there is no need to take any
action.

A set of conditions that specify file content, for example, credit or debit
card numbers, or bank account details near to other forms of personally
identifiable information. There are two types of Content Control List:
SophosLabs Content Control List and custom Content Control List.

A rule that contains one or more Content Control Lists and specifies
the action that is taken if the user attempts to transfer data that matches
all the Content Control Lists in the rule to the specified destination.

An application that is prevented from running on your computer by
your organisation's security policy.
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custom rule

data control

data view

description bar

device control

extensive scanning

firewall event

firewall policy

global rules

hidden process

high-priority global
rule

A rule created by the user to specify the circumstances under which
an application is allowed to run.

A feature to reduce accidental data loss from workstations. It works
by taking action when a workstation user tries to transfer a file that
meets criteria defined in the data control policy and rules. For example,
when a user attempts to copy a spreadsheet containing a list of
customer data to a removable storage device or upload a document
marked as confidential into a webmail account, data control will block
the transfer, if configured to do so.

The view that displays different data depending on the item selected
in the tree view.

Abar in the log viewer which appears above the data view and contains
the name of the currently selected item in the tree view.

A feature to reduce accidental data loss from workstations and restrict
introduction of software from outside of the network. It works by
taking action when a workstation user tries to use an unauthorized
storage device or networking device on their workstation.

Scans every part of every file.

A situation that occurs when an unknown application, or the operating
system, on one computer tries to communicate with another computer
over a network connection in a way that was not specifically requested
by the applications running on the other computer.

The settings issued by the management console which the firewall uses
to monitor the computer's connection to the internet and other
networks.

Rules that are applied to all network connections and applications
which do not already have a rule. They take lower priority than the
rules set on the LAN page. They also take lower priority than
application rules (unless the user specifies otherwise).

An application sometimes launches a hidden process to perform some
network access for it. Malicious applications may use this technique
to evade firewalls: they launch a trusted application to access the
network rather than doing so themselves.

A rule that is applied before any other global or application rule.
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Host Intrusion
Prevention System
(HIPS)

ICMP

ICMP settings

instant messaging

interactive mode

learning dialog

log cleanup settings

log viewer

manual cleanup

match

NetBIOS

network protocol

non-interactive mode

normal scanning

Overall term for pre-execution behavior analysis and runtime behavior
analysis.

Abbreviation for "Internet Control Message Protocol." A network-layer
internet protocol that provides error correction and other information
relevant to IP packet processing.

The settings that specify which types of network management
communication are allowed.

A category of controlled applications that includes instant messaging
client applications (e.g. MSN).

The mode in which the firewall displays one or more learning dialogs
when it detects network traffic for which it has no rule.

A dialog box that asks the user to choose whether to allow or block
network activity when an unknown application requests network
access.

The settings that control when records are deleted.

A form where users can view details from the event database, such as
connections that have been allowed or blocked, the system log and
any alerts that have been raised.

Cleanup that is performed by using special disinfectors or utilities, or
by deleting files manually.

Equal the content that is defined in a Content Control List.

Abbreviation for "Network Basic Input/Output System." Software that
provides an interface between the operating system, the I/O bus, and
the network. Nearly all Windows-based LAN’s are based on NetBIOS.

A set of rules or standards designed to enable computers to connect
with one another over a network and to exchange information with
as little error as possible.

The mode in which the firewall either blocks or allows all network
traffic for which it has no rule.

Scans only those parts of each file that are likely to be infected with a
virus.
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on-access scan

on-demand scan

primary configuration

process settings

Quarantine manager

rawsocket

right-click scan

rootkit

runtime behavior
analysis

scanning error

scheduled scan

secondary
configuration

spyware

stateful inspection

storage device

A scan that intercepts files as they are accessed (copied, moved, saved,
or opened), and grants access to the files only if they do not pose a
threat to your computer or are authorized for use.

A scan that you initiate. You can use an on-demand scan to scan
anything from a single file to your entire computer.

The firewall configuration used for the corporate network that the
user connects to for their day-to-day business.

The settings that specify whether modified or hidden processes should
be allowed network access.

The module that enables you to view and deal with items that have
been quarantined.

Rawsockets allow processes to control all aspects of the data they send
over the network and can be used for malicious purposes.

A scan of file(s) in Windows Explorer or on the desktop that you run
using the shortcut menu.

A Trojan or technology that is used to hide the presence of a malicious
object (process, file, registry key, or network port) from the computer
user or administrator.

Dynamic analysis performed by suspicious behavior detection and
buffer overflow detection.

An error in scanning a file, e.g. access denied.

A scan of your computer, or parts of the computer, that runs at a set
time or times.

The firewall configuration used when users are not connected to the
main corporate network, but to another network such as a hotel or
airport wireless network or another corporate network.

A program that installs itself onto a user's computer by stealth,
subterfuge, or social engineering, and sends information from that
computer to a third party without the user's permission or knowledge.

Firewall technology that keeps a table of active TCP and UDP sessions
and allows small paths along which traffic can pass.

Removable storage devices (for example, USB flash drives, PC Card
readers, and external hard disk drives), CD/DVD drives, floppy disk
drives, and secure removable storage devices (for example, SanDisk
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suspicious behavior
detection

suspicious file

system rule

threat event

tree view

true file type

trusted application

unidentified virus

unknown traffic
virus identity file
(IDE)

Voice over IP

working mode

Cruzer Enterprise, Kingston Data Traveller, IronKey Enterprise, and
IronKey Basic USB flash drives with hardware encryption).

Dynamic analysis of the behaviour of all programs running on the
system in order to detect and block activity which appears to be
malicious.

A suspicious file is a file that exhibits a combination of characteristics
that are commonly, but not exclusively, found in viruses.

A rule that will be applied to all applications and will allow or block
low-level system network activity.

Detection or disinfection of a threat.

The view that controls what data the log viewer displays in its data
view.

The file type that is ascertained by analyzing the structure of a file as
opposed to the filename extension. This is a more reliable method.

An application that is allowed full and unconditional access to the
network.

A virus for which there is no specific identity.

A form of network access by an application or service for which the
firewall has no rule.

A file that enables Sophos Anti-Virus to detect and disinfect a particular
virus, Trojan, worm, or item of spyware.

A category of controlled applications that includes Voice over IP client
applications.

The setting that determines whether the firewall applies actions with
input from the user (interactive mode) or automatically (the
non-interactive modes).
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11 Technical support

For technical support, visit http://www.sophos.com/support.

If you contact technical support, provide as much information as possible, including the following:
m Sophos software version number(s)

m  Operating system(s) and patch level(s)

m The exact text of any error messages
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12 Copyright

Copyright © 2009 Sophos Group. All rights reserved. No part of this publication may be reproduced,
stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical,
photocopying, recording or otherwise unless you are either a valid licensee where the documentation
can be reproduced in accordance with the licence terms or you otherwise have the prior permission
in writing of the copyright owner.

Sophos and Sophos Anti-Virus are registered trademarks of Sophos Plc and Sophos Group. All
other product and company names mentioned are trademarks or registered trademarks of their
respective owners.

The Sophos software that is described in this document includes or may include some software
programs that are licensed (or sublicensed) to the user under the Common Public License (CPL),
which, among other rights, permits the user to have access to the source code. The CPL requires
for any software licensed under the terms of the CPL, which is distributed in object code form,
that the source code for such software also be made available to the users of the object code form.
For any such software covered under the CPL, the source code is available via mail order by
submitting a request to Sophos; via email to support@sophos.com or via the web at
http://www.sophos.com/support/queries/enterprise.html. A copy of the license agreement for any
such included software can be found at http://opensource.org/licenses/cpl1.0.php
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configuring 18
creating 17
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renaming 19
running 19
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D

data control, temporarily disabling 40
dealing with adware in quarantine 32
dealing with controlled applications 35
dealing with PUAs in quarantine 32
dealing with spyware in quarantine 31
dealing with suspicious behavior in quarantine 34
dealing with suspicious files in quarantine 33
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email, allowing 43
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excluding items from on-access scanning 9
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file and printer sharing, allowing 45
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disabling 43
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fragment 71
fragment reported, troubleshooting 72
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G
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getting started
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setting 53, 54, 57
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icons
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Mac viruses, scanning for 21

N
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on-access scan settings 27
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enabling 8
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partial detection 73
password error 75
pre-authorizing suspicious items 37
primary server 67
printer sharing, allowing 45
proxy server 68
PUAs 73, 74
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Quarantine manager 30
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right-click scan settings 27
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spyware
automatic cleanup 27
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suspending scanning 38
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authorizing 37
automatic cleanup 29
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suspicious files in quarantine, dealing with 33
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system tray icon 70

T

technical support 82
threat partially detected 73
types of on-demand scan 13

U

updating 67, 69, 70

updating via dial-up connection 67
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user rights 5, 74

user rights for Quarantine manager, configuring 6
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viewing
custom scan log 20
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